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• Custom-built reporting application

• Loads Excel pivot tables to summarize data from various ledgers

• Provides an enterprise solution for managers’ financial and budgetary data 
access and analysis needs

• Includes 6 workbooks with a total of 34 pivot table reports
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• Special reporting tables are updated nightly at the end of the Financials 
batch processing
• During Fiscal Year End, reporting tables can be updated more often as requested

• Data is loaded into one or more data sheets within an Excel workbook

• Reporting pivot tables are created based on the data sheets

• Fields from the data sheet are brought into the Page, Column, Row, or 
Data area of the pivot table or left on the menu for retrieval by the user
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• Reports across multiple Fiscal Years
• Reports across multiple Business Units
• Customizable reports available to meet individual agency needs
• Identify specific selection criteria, whether basic or complex
• Save criteria selection
• Easy to run – default values on the criteria page make it easy for user to analyze 

data
• Data is refreshed nightly
• Easy accessibility – link is available on the Mine Landing Page

• Or within SABHRS navigate to:
• General Ledger > SABHRS Data Mine > SABHRS Data Mine



DEPARTMENT OF ADMINISTRATION   |    STATEWIDE ACCOUNTING BUREAU

DATA MINE – CRITERIA PAGE TIPS

32

• Lookup buttons are provided to help define valid values

• To get all values, use the % wildcard—not a blank/space

• Blank means blank on the criteria page
• Do not leave a field blank unless you are specifically looking for blank

• If the More Criteria area is collapsed (not viewable), then any parameters 
set there will be ignored when pulling in data
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• Insert/Delete criteria IDs to store different report parameters 
• Having one for each different report you run is a quick, effective way to run reports 

having different parameters

• The From/To Accounting Period/Fiscal Year will default to the current year-
to-date Accounting Period and Fiscal Year
• These search criteria do not get saved

• Select Accounting Period 0 in the From Range when running Accounting 
Balances to include the carry-forward amount, such as balance sheet 
accounts (1xxx-4xxx)
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• Various criteria that is run regularly 
can be saved

• Click on the “create new 
row” button

• Select the desired criteria
• Type in a new name in the 

criteria ID box
• Click save

• For future use, just drop 
down the Criteria ID list and 
choose the desired ID
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• Six workbooks are 
available
• Revenue/Expenditure
• Approp/Org/Rev 

Budgets
• Standard Budget
• Account Balances
• Projects
• Project Budgets
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Revenue/Expenditures
Reports all expenditures and revenue amounts from a specified ledger

The default is the Actuals and A Accrual ledgers

Approp/Org/Rev Budgets
Reports Appropriation, Org, and Revenue Estimate budgets compared to expenditures 
from the Actuals and A Accrual ledgers and revenue recognized from the budget ledger

Standard Budgets
Reports Standard Budgets compared to expenditures from the Actuals and A Accrual 
ledgers
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Account Balances
Reports any ledger account balances from the Actuals and A Accrual ledgers

Projects
Reports expenditures and revenue amounts by project from a specified ledger

The default is the Actuals and A Accrual Ledgers
This workbook is similar to Revenues/Expenditures except that the Project chartfield is in 
the row area of the pivot table

Project Budgets
Reports Project budgets compared to expenditures from both Actuals and A Accrual 
ledgers and the budget ledger
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• Basic Criteria
• Select a General Ledger Business Unit

• Your default Business Unit will be displayed
• Enter a Date Range

• The current Fiscal Year year-to-date range will populate by default
• Even if the dates are changed and saved, the Date Range will not save with the Criteria ID

• Check “Show Acctg Per Detail” to retrieve data by month (accounting period)
• If left unchecked, data will not be viewable by month
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• Enter an Org or Org Range
• Enter an Org or click on the Range select box to enter a From/To range of Orgs

• To choose all Orgs, enter % (no range is necessary)

• Use % to select all values
• Leaving a field blank will search for blank values
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• This example will retrieve data for
• Revenue/Expenditure

• Business unit 51170
• From Month April FY18
• Thru Month June FY18
• All Orgs 
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• To display advanced criteria, 
click the More Criteria link

• Click on the Less Criteria to 
hide Advanced Options

• Use % to select all values

• Leaving a field blank will select 
blank values
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• Choose Grouping Criteria to reduce the number of rows that will be 
retrieved into the data sheets
• Level 2 Account

• Data is grouped by 2 level account (e.g. 62100) as the lowest level; detail account values 
will not be retrieved

• Level 1 Account
• Data is grouped by 1 level account (e.g. 62000) as the lowest level; detail and 2 level 

account values will not be retrieved
• Level 0 Account

• Data is grouped by an account category (e.g. 60000) as the lowest level; detail 2 level and 
1 level account values will not be retrieved



DEPARTMENT OF ADMINISTRATION   |    STATEWIDE ACCOUNTING BUREAU

DATA MINE – GROUPING 

43

• Fund Type
• Data is grouped by Fund Type (e.g. 01, 02); detail fund values will not be retrieved

• Exclude Projects
• Data is grouped without the Project detail; data will not be available by Project
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• Choose a Fund Code or Fund Code Range
• Enter a fund or click on the Range select box to enter a From/To range of funds
• To enter a Fund Type, enter the 1st two characters of the fund with a wildcard (%) (e.g. 

02%)
• To choose all Funds, enter %; no range is necessary

• Choose an Account or Account Range
• Enter and Account or click on the Range select box to enter a From/To range of 

Accounts
• To retrieve a specific category of Accounts, use the wildcard (%)

• For example, 61% will retrieve all personal services expenditures; no range is necessary
• To choose all Accounts, enter %; no range is necessary
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• Choose a Project or Project Range
• Enter a Project or click on the Range select box to enter a From/To range of 

Projects
• To retrieve a specific category of Projects; use the wildcard (%)

• For example, %04 will retrieve all Projects ending in 04; no range is necessary
• To choose all Projects enter a %; no range is necessary

• Choose a Program Year
• Enter % to select all

• Choose a Subclass
• To retrieve a specific category of Subclasses; use the wildcard (%)

• For example, 590% will retrieve all Subclasses beginning with 590
• To choose all Projects enter a %
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• Choose an OBPP Program
• Enter % to select all

• Choose a Source of Authority
• For example, HB2, HB3, SA Statutory, etc.

• Choose a Ledger
• This only applies to Revenue/Expenditures, Account Balances, and Project 

Workbooks
• Choosing ACTUALS will retrieve data from both ACTUAL and A_ACCRUAL ledgers
• Other ledgers such as ENTITYWIDE can also be chosen
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• This example will retrieve data for
• Revenue/Expenditure

• Business unit 51170
• From Month April FY18
• Thru Month June FY18
• All Orgs 
• Grouping Criteria level 2 

Account
• All Funds in the business 

unit 51170 starting with 02
• All Accounts, Projects, 

Program Years, Sub-
Classes, OBPP Programs, 
Sources of Authority and 
ledgers 
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Click the Load Excel Workbook button
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• Revenue/Expenditures Workbook
• Expenditures by Org
• Expenditures by Account
• Expenditures by Org Account
• Expenditures by Fund
• Expenditures by Subclass
• Revenue by Fund
• Revenue by Account
• Revenue by Fund, Account
• Revenue -- Expenditures by Fund, Org
• Revenue -- Expenditures by Org, Account
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• Approp/Org/Rev Budgets
• ORG Budget by OBPP Program, Fund, Subclass

• Org Budgets by OBPP Program, Fund, Subclass; compared to Actuals/A Accrual 
Expenditures

• ORG Bud by OBPP Program, Subclass, Fund
• Org budget by OBPP Program, Subclass, Fund; compared to Actuals/A Accrual 

Expenditures
• ORG Bud by OBPP Program, Source of Authority

• Org Budgets by OBPP Program, Source of Authority (HB2, HB576, etc.); compared to 
Actuals/A Accrual expenditures

• To view details, double click on the non-HB2 group
• The first time, select the field to see the detail; usually Source of Auth
• Double click again to summarize
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• Approp/Org/Rev Budgets
• Org Budgets - No A Accrual

• Org budgets compared to Actuals expenditures
• Use this report to view Org Budgets compared to Actuals expenditures only, without A Accruals

• APPROP Bud by OBPP Program, Subclass, Fund
• Approp budgets by OBPP Program, Subclass, Fund; compared to Actuals A/Accrual 

expenditures
• REV/EST Bud by Org, Fund, Account

• Revenue Estimate budgets by Org, Fund, Account; compared to recognized amount on 
the budget ledger
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• Standard Budgets
• Budget Comparison

• Compare APPROP, ORG and Standard budget amounts
• Use this report to determine whether APPROP and ORG budgets match or whether Standard 

Budgets match ORG budgets

• Standard Budgets by Org, Account
• Standard Budgets by Org, Account; compared to Actuals/A Accrual expenditures

• Standard Budget by Org, Fund Account
• Standard Budgets by Org, Fund, Account; compared to Actuals/A Accrual expenditures

• Standard Budgets by Org, Account, Month
• Standard Budgets by Org, Account, Month; compared to Actuals/A Accrual expenditures
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• Account Balances
• Account Balances

• Reports balance of any account
• Similar to the Trial Balance report
• To include the beginning balance, choose “From” Period 0 on the criteria page

• Balance Sheet
• Reports assets and liabilities and groups equity, revenue, and expenditures together in 

one report
• Double click on the Equity+Rev+Exp group to view details
• Double click again to summarize
• To include the beginning balance, choose “From” Period 0 on the criteria page
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• Projects
• Exp by Project
• Exp by Project, Fund
• Exp by Project, Account
• Exp by Project, Org, Fund, Account
• Exp by Org, Project, Account
• Rev by Project, Account
• Rev by Org, Project, Account
• REV-EXP by Project
• REV-EXP by Fund, Project
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• Project Budgets
• Project Budgets compared to Budget Expenditures

• OPI is the only agency using Project Budgets at this time
• Project Budgets compared to Actuals Expenditures

• OPI is the only agency using Project Budgets at this time
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• Save and/or close any reports that were previously run before running a new 
report

• When a pivot table is refreshed, related pivot tables will also refresh
• Double click on a dollar amount to drill down for more detail

• A new sheet appears, displaying the requested detail
• To delete the detail sheet, click Edit > Delete > or Right-click the sheet tab and select 

delete 
• Clicking on the X in the upper right-hand corner of the sheet will close the entire workbook and 

the report will need to be re-run

• Data sheets available at the end of each workbook contains the detail data for the 
pivot tables
• Users can access these to do advanced Excel functions such as Autofilter, Subtotals, etc.
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• Within the Data Mine 
application
• Click the link Data Mine Manual 

• This links to the Data Mine 
Manual

• Click the link Downloading to 
Excel Help
• This links to the Downloading 

Excel Help document
• Additional resources can be 

found on the SABHRS 
documentation page in 
ServiceNow

https://montana.servicenowservices.com/sp?id=kb_view2&kb=d2a99db91be46410b392ed3ce54bcb06
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• Reports can be scheduled (specific times in drop down)
• This is encouraged to avoid heavy use during core hours

• Reports can be scheduled with recurrence
• This is to run the report automatically daily, weekly or monthly

• Reports can be distributed; even after the report has been run successfully

• Reports can be scheduled to be distributed through email

• Reports are available in the report repositories for five calendar days
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• Steps to run standard reports
• Select the report to run and create (or select) a Run Control ID
• Enter parameters of the desired data (e.g., Chartfields, dates, etc.)
• Run the report
• Check the status of the report
• View, print or save the reports results
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• Report cannot be viewed until run status displays Success and distribution 
status displays Posted, depending upon how the status is checked

• Run Status and reports can be checked both through the Process Monitor 
and the Report Manager
• Navigate from Main Menu

• People Tools > Process Scheduler > Process Monitor
• Reporting Tools > Report Manager

• Through Report Manager one can check the progress of the report 
request, view report content, and manage the history of all reports that 
were run for the previous five days (calendar days, not working days), 
including the reports that were run by someone else on another user's 
behalf
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• The Process Monitor allows 
one to view the progress of 
the report request (even 
those that did not 
complete) and to view the 
completed report
• Process Monitor will not list 

reports run by someone else 
on a user's behalf

• Check the report status

• Alternatively, status can be 
check in Report Manager
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• Click on the Process 
Monitor link to see the 
status and to retrieve 
the report

• Or navigate from Main 
Menu
• PeopleTools > Process 

Scheduler > Process 
Monitor
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• The processing goes through multiple 
stages

• Click the refresh button until the Run 
Status is Success

• Queued/Initiated
• This places the report in line for processing

• Processing
• This is the actual processing of the report

• Success
• The report has run successfully

Click on the Details link to view the report.
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• Report Manager
• Administration tab

• Statuses of the report is the 
same Process Monitor

• Details links available one 
report shows Posted status
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• Historical data up to seven 
business days can be 
retrieved in Process 
monitor
• Select how many days of 

data to display
• Select refresh
• Find reporting instance to 

open

• Sort columns by clicking 
on the header
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• If the report displays a status of Error, click the Message Log or 
View Log/Trace link to determine the cause of the error

• Once error is determined, correct Run Control parameters; re-run 
in order to view the requested data
• The status of Error indicates the report did not complete

• Other potential results

Status Description
Queued Report is scheduled, or about to commence
Initiated System has begun to process report request
Processing Currently in progress
Scheduled or Queued Report will run at a future date/time
Posting Repositories are being updated with report information
No Success or Error Process failed
Posted or Success Process completed successfully
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Click on the View 
Log/Trace link
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• Click on the .PDF 
link to open the 
report

• PDF can be saved 
or printed
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• Three ways to access a report in order to view and print the report
• Process Monitor
• Reports Manager
• My Reports Pagelet



DEPARTMENT OF ADMINISTRATION   |    STATEWIDE ACCOUNTING BUREAU

REPORTING – REPORT MANAGER

71

• Only the reports which completed successfully will be listed in Report 
Manager

• Lists each report request and the time the request was run

• Includes those reports the user has run in addition to the reports run on the 
user's behalf by someone else

• To view what time recurring reports are scheduled to run, or to view report 
that did not run successfully, the Process Monitor must be used
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• Report Manager can be 
accessed several ways
• Click the Report 

Manager link of the 
Report List pagelet 
(demonstrated later)

• Navigate through the 
Main Menu
• Reporting Tools > 

Report Manager
• Click the Report 

Manager link on the Run 
Control page of any 
report
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• The List tab shows the name 
of the report, when the report 
was successfully completed, 
and the process instance 
number of the report

• The Administration tab 
details which reports have 
run (or been run by someone 
else) in the last five days, the 
process instance number for 
each report, when the report 
was requested, and the 
report format and status
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• On List Tab
• The report can be viewed by clicking the report name link

• Click report Detail

• On Administration tab
• The report can be viewed by clicking the link in the Description column or the Details 

link
• These links will only appear after the report has run successfully

• The Report Detail page displays the name of the report and the associated output 
and message log links

• Clicking the name of the report displays the report in a new window
• Print the report by clicking the Print button in the browser bar

• If the report is in PDF format the print icon in the Adobe Acrobat toolbar must be used



DEPARTMENT OF ADMINISTRATION   |    STATEWIDE ACCOUNTING BUREAU

REPORTING – OUTPUT OPTIONS

75

• Output type tells the system where to allow the report to be viewed

• Select one of the three options available from the Type dropdown list

• Three Types
• Email

• The report will be distributed in an email (be careful if running a large report so that 
the file size does not exceed email limitations)

• Web
• Web is the recommended output type
• The report is sent to both the Process Monitor and the Report Manager

• Window
• A new window will open, displaying the report
• The report can still be accessed through the Process Monitor and Report Manager
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• Select an output option from the Format dropdown list

• Format determines the output of the report

• Formatting options available for each report are based on the process type
• Format options

• CSV (Comma Separated Variable) – View in Excel, (no formatting included)
• LP (Line Printer) – View as a text file in Textpad or Notepad (no formatting included)
• PDF (Portable Document Format) – View in Adobe Acrobat; document is read only
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• To send a report 
to another user(s)

• Click the 
Distribution link to 
display the 
Distribution Detail 
page
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• The recipients of the 
report are listed below 
the Distribute To section

• By default, the sender’s 
ID is listed first

• Click the Add a row icon     
to insert additional rows, 
one row for each user
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• Reports can be scheduled to run at a future date, multiple times, or at the 
same time on a regular basis

• To set a schedule for the report to run, navigate to the report and enter a 
run control and the desired report parameters, click the Run button

• The default setting for recurrence is none, as many reports will run 
infrequently or on an as-needed basis

• On the Process Scheduler Request Page, select one of the pre-defined 
recurrences available from the recurrence dropdown list and click the OK 
button

• Scheduling is recommended for large amounts of data
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• Navigate from Main Menu
• PeopleTools > 

Process Scheduler > 
Process Monitor

• Select the recurrence of the 
report 

• A scheduled report can be 
distributed to others 

• Click the Distributions link to 
allow other users to access 
the report
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• The status of scheduled 
reports can be checked 
through Process Monitor

• Scheduled reports will 
appear with a status of 
Queued until the report 
has completed

• The Process Monitor 
shows when the report is 
scheduled to run, or 
when it is running
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• Reports that are in a 
Queued status can be 
canceled, held, queued, or 
restarted at any point 
through Process Monitor

• To postpone the report, 
click on either the Details 
link or the Recurrence icon
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• If the recurrence icon 
is chosen, the report 
can be postponed by 
clicking the Hold 
button

• At any time in the 
future this report can 
be restarted by 
navigating back to 
this page and clicking 
the Restart button
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• If the Details link was 
clicked to postpone the 
report, click the radio 
button next to Hold 
Request in the Update 
Process section

• In the future this report 
could be restarted from 
this page by clicking on 
the Queue Request radio 
button

• To stop the request 
completely, click the radio 
button next to Cancel 
Request
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• The reporting pagelet lists 
the reports available

• Access any of the reports 
by clicking the Report 
name

• Access Report Manager 
by clicking Report 
Manager link
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• Adding the Reports 
Pagelet 

• From the SABHRS 
Financials home page 
select the Content link
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• Select the Report 
List checkbox, 
then click the 
Personalize 
Layout link
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• Choose preferred 
layout and personalize 
as desired

• Click Save when 
complete
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• Navigate from Main Menu > General Ledger > General Reports > MT 
Org/Project Reports

• Four reports are available
• MT Org Detail Report
• MT Org Summary Report
• MT Project Detail Report
• MT Project Summary Report
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• A Run Control ID is a database record that tells the system what settings 
you want for the report

• There are no limits on how many Run Control IDs a user may have, and it 
is strongly suggested that a unique Run Control ID for each type of report 
is set up

• Once a Run Control ID has been created and saved it may be re-used for 
the processes and reports in that module

• Once a Run Control ID has been created it cannot be deleted
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• Run Controls are 
required for multiple 
types of reports

• General Ledger  
Reports are located 
under the  Main Menu 
> General Ledger > 
General Reports
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• Select or create a Run 
Control ID
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• This report will 
populate the following 
information
• Business unit: 69010
• Fiscal Year: 2018
• Period: 12
• Org Value:

• 01ADMIN

• Once the parameters 
have been entered 
click the Run button. 
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• Process Scheduler options
• When and how often 

the report will run 
(Recurrence)

• What report option to 
run

• In which format the 
report will display

• To whom the report will 
be distributed
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• Two processes are available to choose
• Org/Project Detail report

• Reports budget, actual journal 
details and encumbrance 
activity by Org; also includes 
Section E for Standard Budget 
reporting

• Org/Project sum PART-C
• Reports budget, actual journal 

details and encumbrance 
activity by Org; Part C 
transactions are summarized 
and includes Section E for 
Standard Budget reporting

Select desired process and press OK.
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• Report can be run at the 
Org level or Tree level 

• If run at a Tree level the tree 
structure of the agency will 
need to be known

Click Run.



DEPARTMENT OF ADMINISTRATION   |    STATEWIDE ACCOUNTING BUREAU

REPORTING – ORG SUMMARY REPORT

98

• Process Scheduler 
Request
• Org report type
• Org Summary Report 

Click OK.



DEPARTMENT OF ADMINISTRATION   |    STATEWIDE ACCOUNTING BUREAU

REPORTING – ORG SUMMARY REPORT

99



DEPARTMENT OF ADMINISTRATION   |    STATEWIDE ACCOUNTING BUREAU

REPORTING – TRIAL BALANCE FUND

100

• Navigate from Main Menu > General Ledger > General Reports > Trial 
Balance - Fund

• Trial Balance – Fund
• Displays a trial balance by specified fund
• A total trial balance of shared funds can be generated by leaving the unit field blank



DEPARTMENT OF ADMINISTRATION   |    STATEWIDE ACCOUNTING BUREAU

REPORTING – TRIAL BALANCE FUND

101

• Choose a Run Control ID or set up a new one

• Run Control Parameters
• Unit (not required if you select a specific fund)
• Ledger (if left blank will default to ACTUALS)
• Fund Code (% or wildcard can be used)
• Fiscal Year (if left blank will default to current year)
• To Period (July is period 1, August period 2, etc.)
• Currency Code (leave as USD)
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• This report has the 
following parameters
• Unit: Blank (will return all 

Bus that use this fund)
• Ledger: ACTUALS
• Fund Code: 06522
• Fiscal Year: 2020
• To Period: 12 or June

Once the parameters have been entered click the Run button.
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• Process the report

• Trial Balance - Fund 
report is selected

• Type: Web

• Format: PDF

Click OK.
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• On the report each          
business unit has their 
own section and totals

• At the end of the 
report is a total for all 
business units



DEPARTMENT OF ADMINISTRATION   |    STATEWIDE ACCOUNTING BUREAU

REPORTING – TRIAL BALANCE

105

• Navigate from Main Menu 
• General Ledger > General Reports > Trial Balance

• Combines detail and summary balance information

• Generates trial balance by business unit for all funds

• Shows the ending ledger balances for the specified year and period by 
Chartfield combination and account

• Displays subtotal by Chartfield

• Displays total for debits and credits

• More flexible to include other Chartfields
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• Four reports are available
• Trial Balance Report
• Trial Balance – A Accruals
• Trial Balance – Combined (Actuals and A Accruals)
• Trial Balance Rpt Entitywide
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• Select or Create a Run 
Control ID

• Enter Run Control 
parameters 

• Click Refresh 
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• Once Refresh clicked, chartfield selection is expanded (1 time only, then 
Refresh after clears parameters)
• Allows for customization of

• The order of selected fields
• The values or range of values
• Field subtotals
• Only the fields selected will appear on the report
• If the report is blank check the selected Chartfields
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• Sequence
• Specifies order in which the 

selected fields appear
• To change order simply type 

the number of order in the 
field

• Include CF
• Click to include

• Subtotal
• Click to display a subtotal for 

specific chartfield
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• Value and To Value
• Used to more 

specifically define the 
report

• The (%) wildcard 
cannot be used in 
these fields; valid 
values must be entered 
or leave blank to return 
all values

Click save and then run.
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• Select the report or 
reports to run

• Select the type

• Select the format
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• The trial balance displays Chartfield selection parameters
• This report can Be customized to meet the needs of the agencies
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• Inquiry can be conducted upon the Actuals, Standard Budget, or 
Entitywide ledgers
• Does not include any controlled budget ledgers

• Ledger data can be gathered for specified business unit, fiscal year, and 
accounting periods

• Data is summarized in various pre-defined layouts, including Sum by 
Period, Account or Sum by Period, Ledger Activity, and Ledger Balance

• Data that matches the criteria will be displayed in the layout selected
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• Navigate from Main Menu
• General Ledger > Review 

Financial Information > 
Ledger

• An Inquiry name is 
required and is similar to a 
Run Control ID

• Select an existing value or 
add a new value
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• The Unit, Ledger, Fiscal Year, From Period, and To Period fields are required

• Enter values in each field or select from the list by using the lookup icon

• Additional parameters may be selected by clicking the box in front of the 
desired option

• Specify the desired chartfield values under the chartfield criteria

• Click Clear to remove all previously selected criteria
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• When all desired 
Chartfields and 
values have been 
entered, click 
Search 
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• The Ledger 
Summary page 
shows a summary 
of the ledger 
amounts

• Click on the Details 
link to view the 
Ledger Details page
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• Click the Activity 
link to view the 
Transaction 
Detail
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• Related journals will 
appear

• Click the Journal ID link 
to drill down further
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• This screen shows 
the header and lines 
detail for the Journal 
ID selected

• Click Query Journal 
Lines to see all 
journal lines 
associated with this 
Journal ID
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• Reporting tool that extracts data from SABHRS

• Navigate from Main Menu
• Reporting Tools > Query > Query Viewer
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• Queries can be found by 
entering the first few 
characters of the query 
name in the text field

• Click Advanced Search 
link for more search 
parameters if the name 
of the query is unknown

A complete listing of available queries and reports is 
available on SABHRS documentation page



DEPARTMENT OF ADMINISTRATION   |    STATEWIDE ACCOUNTING BUREAU

REPORTING – QUERIES 

123

• Use the drop-down 
arrows to select more 
search criteria such 
as contains, 
between, not=, or by 
Folder Name

• All queries have been 
sorted into the 
appropriate folders by 
module (e.g., AP, GL, 
AM, etc.) Click the Search button to retrieve the queries.



DEPARTMENT OF ADMINISTRATION   |    STATEWIDE ACCOUNTING BUREAU

REPORTING – QUERIES 

124

• Add a query to Favorites by clicking the Favorite link in the associated row

• Subsequently the query will be listed under My Favorite Queries
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• Output Options
• HTML

• Advantages
• Can print viewable data
• Can use print preview

• Disadvantages
• Can’t perform any data manipulation
• Can’t sort
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• Run to HTML
• Click the HTML 

link associated 
with the query

• Note: In most cases 
the parameter fields 
cannot be blank  

• If not looking for 
specific field enter a 
wildcard character 
(%), but can only be 
used when criteria 
is “like”
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• Results of the query will not be saved in the Reports Manager or Process 
Monitor unless the query was scheduled

• If results need to be saved the query must be run in an Excel or CSV Text 
file and saved to the local or network drive
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• Although the initial 
selection was run to 
an HTML window; 
the results can be 
downloaded to 
Excel and formatted 
as an Excel 
spreadsheet, or as a 
CSV.ext file by 
clicking the 
appropriate link
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• Output Options
• Excel

• Advantages
• Data is formatted
• Leading zeros appear

• Disadvantages
• Must “Save As” an .xls file 
• Must close or save current worksheet in order to re-run same query with different 

criteria
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• Run to Excel
• Click the Excel link 

associated with the 
query

• Enter search criteria 
and click View 
Results
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• A1 -- Query Name

• B1 -- Total number of rows
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• Queries can be scheduled to run at a future date, multiple times, or at the 
same time on a regular basis

• Can be scheduled to run both through the Query Viewer as well as through 
the Schedule Query

• The description entered will show up in the Process Monitor and Report 
Manager if the query is scheduled through Schedule Query, but not if it is 
scheduled through Query Viewer
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• Schedule through Schedule Query
• Navigate from Main Menu

• Reporting Tools > Query > Schedule Query
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• Run Control IDs are 
specific to queries

• If scheduling for the 
first time either a new 
Run Control ID or an 
existing one can be 
used
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• Select a query to run 
by entering the query 
name or the first part 
of the query name, 
and then click the 
Search button
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• A pop-up will generate 
prompting for Parameters

• Enter the description to 
appear in the Reports 
Manager for this query and 
click the Run Button

• Add necessary              
parameters in Value fields
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• The Process 
Scheduler Request 
page prompts for 
various selections

• Enter the desired Run 
Date, Recurrence, 
Type, Format, and 
Distribution recipients 
and click the OK 
button
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• Check the status or 
view results of the 
query via the Process 
Monitor or Report 
Manager
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• Schedule through Query Viewer

• Navigate from Main Menu
• Reporting Tools > Query > Query Viewer

• Find an existing query or search for the desired query
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• Click the Schedule link in the associated row
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• As previously demonstrated, 
select an existing Run Control 
ID or add a new one 

• Fill in the parameters for the 
desired results and click the OK 
button
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• Enter the desired 
Run date, 
Recurrence, Type, 
Format, and 
Distribution 
recipients and click 
the OK button

• Check the status or 
view results through 
either Process 
Monitor or Report 
Manager
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• Resources can be found on the SABHRS documentation page
• Reporting (manual and user guides)
• Financial Reports Listing
• GL Journals Manual

https://montana.servicenowservices.com/sp?id=kb_view2&kb=d2a99db91be46410b392ed3ce54bcb06
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ServiceNow
Phone: 444-3092

https://servicedesk.mt.gov/
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